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Web Confidential

Introduction
by Alco Blom

If you are anything like me, you've probably got a growing number user IDs,
passwords, registration keys, PINs, serial numbers, and the like, stored in various
places on your Mac or scribbled on miscellaneous pieces of paper around your home
or office. When you stop and think about it, you probably have more of these pesky
bits of information scattered about than you realize.

The proliferation of the Internet is exacerbating this situation. Increasing numbers
of commercially-oriented sites, such as the NY Times, require some form of
registration even simply to view content. Other transaction-oriented sites, such as
Amazon.com, or personalized sites, such as My Yahoo, require passwords for
personal services. Many sites now use cookies to track users, but if your cookies files
get deleted or corrupted, you'll have to re-enter your usernames and passwords.

I decided to write a software program to manage passwords and the like; it is called
Web Confidential. It uses an intuitive, easy-to-use cardfile metaphor which will
enable even novice users to get up to speed in no time. Power users will find a large
number of options to enable them to configure Web Confidential to meet their
specific needs. I think you will be especially impressed by the tight integration Web
Confidential offers with your favorite Internet applications, such as Netscape
Navigator, Microsoft Internet Explorer, Fetch and Anarchie. I've taken full
advantage of the Mac OS's outstanding facilities, such as Interapplication
Communication and Shared Menus, to make Web Confidential work seamlessly
with these programs.

Last but not least, Web Confidential permits you to encrypt your password files,
protecting this sensitive information from prying eyes, using the state-of-the-art
“Blowfish” algorithm [1]. The Blowfish algorithm was published four years ago, and
has been proven extremely resilient to cracking. No known succesful cryptanalysis
against Blowfish exists. Web Confidential supports keys of up to 448 bits in length.
As an alternative, you can also use PGP for encryption.

[1] - Applied Cryptography, Bruce Schneier, 1996. John Wiley & Sons, Inc.

(see also <http:/ /www.counterpane.com>)
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Web Confidential

Requirements

Web Confidential runs in 1 Mb of RAM. The application size is around 500K.
Including documentation, Web Confidential requires around 1 Mb of harddisk
space. The 68K application distributed on the Internet is around 250K. After
registration you will receive the PowerPC/FAT application which is 500K.

The PowerPC/FAT application runs faster on PowerMacs. Choose Get Info under
the File menu to find out which version you have.

Web Confidential needs System 7 or higher. The Shared Menus feature of Web
Confidential requires System 7.1 or higher. Web Confidential is Mac OS 8 savvy.
Web Confidential does not require any special files or extensions.

After running the Web Confidential Installer, you will have a new folder called
Web Confidential 1.0. To use Web Confidential, just launch the application.

Limitation of Liability

Under no circumstances including negligence, shall Alco Blom be liable for any
incidental, special or consequential damages that result from the use or inability to
use Web Confidential, even if Alco Blom has been advised of the possibility of such
damages.
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The Concept Of Shareware

Web Confidential is distributed under the so-called “shareware” principle. This
means that you are expected to pay a modest registration fee of $25 if you continue to
use the program beyond a trial period of 30 days. Within this trial period, you have
full access to all of Web Confidential's features but one: you cannot encrypt your
password files. After thirty days of use, you cannot add new cards but you can
continue to view and edit existing cards. Upon payment of the registration fee, you
will be issued a registration key which removes these restrictions. Payment of the
registration fee entitles you to all subsequent incremental upgrades. In addition, the
wishes of registered users will be taken into account in future enhancements of the
program.

Although freely distributed via the Internet and on CD-ROM collections, Web
Confidential is not public domain software; it is commercial software which is
professionally developed and supported. It represents many hours of work by its
developer, whose primary source of income is derived from the development of
shareware software for the Mac. Your registration payment ensures the continued
viabilty of high-quality software developed by independent developers committed
to the Mac.

We trust that you will honor the shareware concept and register Web Confidential if
you continue to use it.

To encourage you to pay the shareware fee, the unregistered version of Web
Confidential has the following two restrictions:

1) After 30 days of use, the encryption feature will be disabled. You can save your
data to disk, but you cannot encrypt it.

2) After 30 days of use, you cannot add any new records to your files. However, you
can still view and edit your exisiting data.

After you register the program, these restrictions are removed.
Web Confidential costs $25. You can register on the WWW using this URL:

<http:/ /order.kagi.com/?AB>



http://order.kagi.com/?AB

Web Confidential

Getting Started

The Getting Started section contains a brief tutorial to help you get up to speed
quickly using Web Confidential. In it, you will be introduced to the following topics:

Creating Web Confidential cards directly

Adding a card from within your Web Browser

The Web Confidential toolbar

The categories and fields of Web Confidential cards
Launching pages from within your Web Browser
Launching a password-protected page

Working with passwords
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Creating Web Confidential cards directly
To add cards directly in Web Confidential, proceed as follows:

Open the Web Confidential folder on your harddisk and double click on the Web
Confidential icon to start the program.

You will be presented with an empty card (see picture below). Your new password
file will be assigned the default name “Untitled 1”.

O S Sa])b—m Untitlel | —am0"——=H
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o Go Copy F. Find Key Save Add Celete
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Let's start by creating a card for your Internet Service Provider (ISP) account. This is
the company or organization with which you have an account for Internet access.
Typically, you were issued a username and password when you opened your
account. We will now create a Web Confidential card containing this information.

By default, Web Confidential displays a card structured for a World Wide Web
(WWW) page address. This means that each of the four fields in labelled
appropriately for a Web page address.
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To select a different category of card, click the card category popup menu - it
currently displays “WWW Pages”.

Select “Login Accounts”. A “Login Account” card is the appropriate card type for
storing the details of your ISP account.

Click on the Add button in the Web toolbar.
In the field Name, enter the name of the ISP.
In the field Host, enter the name of the host as a Telnet address.

In the field Login, enter your username. Do not confuse this with your real name;
you username will be one word with no spaces. It is usually a combination of letters
from your first and last name. It is usually not case-sensitive.

In the field Password, enter your password. Keep in mind that in contrast to your
username your password is almost certainly case-sensitive; remember to enter
exactly as it was issued by your ISP.

Notice that your password is not displayed as you type, but rather bullets are
substituted for each letter. This is for reasons of confidentiality, namely to prevent
an onlooker from being able to see your password.

To ensure, however, that you have indeed entered your password correctly, you can
view it by clicking on the Eyeglasses icon next to the Password field. This will
display your password in a Help Balloon.

You have now created your first Web Confidential card. Before you go any further,
take a moment to save this password file to disk. Click the Save button from the
toolbar. The Save File dialog will prompt you for a filename for your password file.
The Web Confidential default is “Untitled 1”; presumably you will want to change
this to something more meaningful to you. Once you have given your Web
Confidential password file a distinctive filename, simply clicking the Save button
periodically will save changes to your password file as you work.
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Adding a card from within your Web Browser

One of the outstanding features of Web Confidential -- one that sets it apart from
simple cardfile programs -- is its tight integration with your Web Browser. As you
will see below, Web Confidential can send an URL to your Web Browser, meaning
you don't have to Cut and Paste information manually -- Web Confidential handles
this chore automatically. But this integration doesn't stop there. Web Confidential
can also receive information from your Web Browser. You can in fact add a card
from within your Web Browser with a single keystroke.

To add a card from within your Web Browser, proceed as follows:

First, make sure Web Confidential is running. Then start your Web Browser (for
many people this will be either Netscape Navigator or Microsoft Internet Explorer;
Web Confidential works with both programs.)

You will notice that Web Confidential has added three icon menus to the menu bar
of your Web Browser: the Diamond menu, the Key/Lock menu, and the Eyeglasses
menu. (Below Web Confidential’s icon menus in Nescape Navigator’s menu bar.)

Diew Go ¢ % @ 9B s Help

Now, go to a Web Page, perhaps one you've saved in your Bookmarks or Favorites
list.

Go the Diamond menu, and click the first menu item, Add Web Page. Voila! This
URL has now been added to your current Web Confidential password file.

To view the results, switch back to Web Confidential. The card you just added will
be displayed. Web Confidential copies the title of the given Web Page to the Name
field and copies the address to the URL field. You can modify this information as
required. When you are done, save this card to disk by clicking the Save button.

-10 -
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The categories and fields of Web Confidential cards.

If Web Confidential is not open, click on the program icon to launch it. Next, use
the Open command under the File menu to open the password file you created in
the previous section.

Once you have reopened your Web Confidential password file, take a minute to
examine the popup menu used for selecting the category of card in Web Confi-
dential. Web Confidential offers you twelve different types of cards, each with
corresponding fields. When you select a different category of card, the field names
change accordingly. Instead, for example, of a password field, the ATM/PIN Card
Category has a PIN code field.

In designing Web Confidential, we have tried to anticipate your needs for defining
the fields each of various categories. However, it is quite possible that you may want
to store additional information for a given card. To anticipate this situation, we
include a note field.

To view and edit the note field, click on the Show Note checkbox in the lower

lefthand corner of the card. The note field will be displayed. Under System 7, you
can enter up to 255 characters; under Mac OS 8 a note can be of unlimited length.

-11 -
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The Web Confidential toolbar

Now let's turn to the toolbar. The most important functions for manipulating cards
have been assigned buttons on the toolbar. We have already seen the Save and Add
buttons. The remaining buttons include the following:

The Switch to an Internet Application button allows you to launch Internet
applications directly from Web Confidential. By default, it launches your Web
Browser. However, if you click on it and hold the mouse button down, a popup
menu allows you to select a different application, such as an FTP, E-Mail, Telnet, or
Newsreader program. Your selection then becomes the default action for this
button until you make a different selection.

As such, Web Confidential can serve as mini-launch pad for your most frequently-
used Internet programs.

The Switch to an Internet Application button is useful, but it is not nearly as
powerful as the Go button directly to the right.

The Go button expands upon the functionality offered by the Switch to an Internet
Application button by going directly to the URL specified in the second field. It does
this by starting the appropriate application and supplying it with this URL.

For example, create a WWW Page card using an URL from your bookmark file or
any other source. First select WWW Pages from the Category popup menu. Then
click Add. Now fill in the first two fields as you see fit. (The third and fourth fields,
User ID and Password, you can leave blank.) When you are done, click Save.

Now, click on the Go button. If your Web Browser is not currently open, it will be
opened with the URL in field two as the URL destination. If your Web Browser is
already open, this URL will be passed to it. In either case, your Web Browser will
then try to load this page.

The third button from the left, the Copy Password button, allows you to copy a
password to the Clipboard and paste it into another application. This saves you
having to enter your password manually.

For example, create a password card using the Password Manager category. This
might be the password you use to access your personal account information on a site
like Amazon.com. First select Password Manager from the Category popup menu.
Then click Add. Now fill in the first and last fields as you see fit. When you are

-12 -
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done, click Save.

Now, click the Copy Password button. The contents of the last field will be copied to
the Clipboard. If you switch to your Web Browser and position the cursor in the
Password field of an onscreen form, you can use the Paste command from the Edit
menu (or press Cmd-V) to paste your password into this field.

The Find button displays a Find dialog which enables you to search cards.

The Key button allows you to encrypt your Web Confidential password file. This is
a powerful feature, but if it is used incorrectly it can cause you a lot of grief. Please
review carefully Encrypting Password Files in the Reference section before using this

feature.

The Delete button allows you to delete the current card. Use this command
carefully, as it does not prompt you to confirm a card deletion.

-13 -
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Launching pages from within your Web Browser

As you've seen above, you can go to a Web Page from within Web Confidential by
clicking the Go button on the toolbar. However, Web Confidential also allows you
go to a Web Page stored in your password file directly from within your Web
Browser. You can in fact access your list of URLs as easily as you can access your
Web Browser's bookmark or favorites file. First, make sure both Web Confidential
and your Web Browser are running.

Switch back to your Web Browser. Now take a look at the second Web Confidential
menu, the Key/Lock menu.

If you click on this menu, it will display all the Web Page URLs you have added to
the “WWW Pages” category in your password file. If you select one, your Web
Browser will try to load it.

Note: If you hold down the Option Key while making the menu selection, you will be presented the
Card Info Window (see below), which gives you an overview of the data about the Web Page that is
stored in the card.

Web Confidential is smart insofar as it only displays Web Page addresses in your
Web Browser. It does not display entries from other categories of cards.

Card Info
—Card Info
Name: James Bond's Secrets
Home Page: hitp:# Swwew web-confidential .combond s
Uzer |D: james
Password: ssseses &

—Password Commands

Copy #*C I

Press the Copy button to copy the password to the Clipboard.

[+ Automatic access | Cancel ||| bo #b ||

-14 -



Web Confidential
Launching a password-protected page
You will find that Web Confidential really shines when it comes to handling
password-protected Web Pages. See how Web Confidential can automate logging

into a password-protected Web Page by trying this:

Add a new Web Page card to your password file. Here is an URL for a page that is
password-protected:

<htt p://ww. web- confi denti al . coni bond/ >

Now enter in the User ID field:

j anmes
and in the Password field:

bond007
Don't forget to enter a name in the first field; let's call it:

Top Secret Page
You can now launch this page directly by clicking the Go button in the Toolbar.
Web Confidential automates the authorization process for you, making viewing
password-protected pages as easy as unprotected ones.
This concludes the Getting Started with Web Confidential section. By now, you
have been acquainted with the main features of Web Confidential. You can explore

the program further on your own or use the Reference section to learn about addi-
tional specific features.

-15 -
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Web Confidential
Working with passwords

Some sites, such as Amazon.com, or personalized sites, such as My Yahoo, require
passwords for personal services. You can store these passwords in the category
Password Manager.

The Eyeglasses Shared Menu lists the names of cards from the category Password
Manager. It provides you with quick access to frequently-needed passwords from
within all your Internet applications.

Choosing an item from the Eyeglasses Shared Menu displays the Card Info Window
for that item (see below; the Form Commands are available for Microsoft Internet
Explorer only).

Card Info

—LCard Info

Marne: AMAazan

Home Page: hifp: s A A MNAZ0N.CO M

ID/Description: alco@xsdall.nl

Pagsword: ssseee S
—Password Commands Form Commands

[ Copy #*C [ ID & Password I

| Enter %E | Submit |

[ Cancel ]|| bo ¥b ll

You can click the blue hypertext link or press the Go button to load the Web Page.
Before you do that, however, you can move the mouse over the Eyeglasses icon and
have a peek at your password. You may also first press the Copy button to copy your
password to the Clipboard. Later, you will only have to use Paste (Cmd-V), to enter
your password.

-16 -
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A cool feature is available when you use the Microsoft Internet Explorer 4.01. Whenever
you need to supply a password on a Web Page in a so-called ‘form” you can use the
Enter button in the Card Info Window to enter the password automatically.

Below is a part of the “form’ on the “Amazon.com Account Access’” Web Page. Just
pressing the Enter button in the Card Info Window automatically sets this password
field. It is not even necessary to use Paste!

Yhat is your e-mail address?
M e-mail address iz

Yhat is ¥our AmMazon.com passwornd?

o {1 amanew user, or I have forgoten my old passvword and wrould
like to create a new account.

L {0 T am & returning vser, and my password is

Go 1o the [ Account Maintenance] Page

Many sites, like in the example above, actually require two pieces of information. A
user ID (or e-mail address) and a password. You can use the ‘ID & Password’ button
to enter these two fields automatically. After pressing the ‘ID & Password’ button the
dialog is dismissed.

You can even try to also automatically submit the form. Pressing the ‘Submit’
button will first enter the user ID and password field and then submit the form.

-17 -
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Reference
Web Confidential main window

The main window of Web Confidential comprises the following elements (from top
to bottom): a toolbar, a status line, the card category popup menu, the four fields of
each card, and, at the bottom, the Show Note check box and the help icon. To the
right of first field is the navigation button (arrowhead icon), to the right of the
second is the card attributes button (checkmark icon), and to the right of the fourth
is the Eyeglasses icon. In the lower righthand corner is the Apple Help Balloon
toggle and the Web Confidential Help button.

Web Confidential toolbar

The Web Confidential toolbar comprises the following buttons, which offer quick
access to the main features of the program:

Switch to an Internet Application

The Switch to an Internet Application button launches an Internet application from
within Web Confidential. By default, it launches your Web Browser. However, if
you click on it and hold the mouse button down, a popup menu allows you to select
a different application, such as an FTP, E-Mail, Telnet, or Newsreader program.
Your selection then becomes the default action for this button until you make a
different selection.

This default is saved to disk when you exit and is restored the next time you launch
Web Confidential .

Go

The Go button is similar to the Switch to an Internet Application but launches the
Internet application with the URL specified in the second field of the currently
displayed card. If the application you select is already open, this URL will be passed
to it and the browser will try to load this page in its currently active window.

When you keep the mouse button pressed a little while longer, the Go button

displays a popup menu listing all of the cards of the currently active card category. If
you select an item from the popup menu Web Confidential will go to that URL.

-18 -
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Copy Password

The Copy Password button allows you to copy a password to the Clipboard and paste
it into another application. This saves you having to enter your password
manually. It also shields the password from view for the sake of confidentiality.
This function is also available from within your Internet applications by means of
the Eyeglasses Shared Menu (see below).

Find
The Find button displays a Find dialog which enables you to search cards. It offers
two options:

e Wrap around: start the search from the current card and continue the search from
the top of the password file. Default: off

e Ignore case: perform case insensitive searches. Default: on

Key

The Key button allows you to encrypt your Web Confidential password file. It
shows the window shown below. Enable the option “Encrypt On Save” if you want
to encrypt your password file when choose Save.

File Encryption

_ [+ Encrypt On Save

Enter your encryption key below.

I l||l||||-| &

Important: remember this key well. ¥ou need this key o
decypher the file later. |f you lose or forget this key, you will
no longer be able to access this file, Your data will be 1ost
farever.

dbout Keys. .. I [ﬂ]

Please review carefully “Encrypting Password Files” below before using this feature.

-19 -
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Save
The Save button saves your data to disk. Depending on the setting “Encrypt On
Save” (that you can set via the Key button), the file is saved normally or encrypted.

Add

The Add button allows you to add a new, blank card to your current password file. It
adds a new card of the type currently selected in the card category popup menu. To
add a card of a different type than currently displayed, first select a different type
using this menu, then press Add.

Delete
The Delete button allows you to delete the current card. Use this command
carefully, as it does not prompt you to confirm a card deletion.

Web Confidential status line

The Web Confidential status line, which is located directly under the toolbar,
contains the following items: on the left-hand side is an icon which indicates
whether a password file will be encrypted on Save or not, in the middle is the
context-sensitive command help line, and on the right is card index indicator. This
displays the card number and the total number of cards in the selected category.

Web Confidential card fields

Each card in Web Confidential has four standard fields. They are labeled in various
ways, depending on the type of card you have selected using the card category popup
menu. In addition to the four standard fields, there is an optional note field for
adding miscellaneous information about each card. By default, this is not displayed;
to view or edit the contents of a note field, activate the Show Note check box in the
lower lefthand corner of the main window.

To the right of the top field is the navigation button (the "arrowhead" icon) . If you
click on this button, it displays a popup menu listing all of the cards of the currently
active card category. They are listed by the entry in the first field. If you select an
item on this list, the corresponding card will be displayed.

To the right of the second field is the card attributes button (the "checkmark" icon).
These attributes govern the behavior of Web Confidential when loading an URL
entered in this field. If you click this button, it displays a popup menu listing the
three URL attributes. If an attribute is checked, it is turned on.

-20 -
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To the right of the fourth field is the Eyeglasses icon. This displays the contents of
the Password field in a Help Balloon.

These are the three URL attributes that you can turn on:

Open in New Window
If the “Open in New Window” option is turned on, this page will be opened in a
new window in your Web Browser rather than an existing window. Default: off.

Automatic Access

If the “Automatic Access” option is turned off, Web Confidential will not include
the username and password in the URL. While most password-protected pages can
be automatically opened this way, a few may not, and you may find you need to
enter username and password manually in a dialog box from within your Web
Browser. Default: on.

Disable history

If the Disable history attribute is checked, URL Manager Pro's history function will
be switched off (if the program is running). This may be desirable for reasons of
confidentiality. Default: off.

In addition to the these three attributes, a fourth menu item is also displayed.

Edit URL

If you select this item, a two-line editing window is opened displaying the contents
of this field. This is particularly helpful for viewing and editing long URLs that are
longer than the standard field display box.

Web Confidential Menu Bar

The File menu has the following commands:

New

The New command creates an empty password file. When you save it for the first
time, you will be prompted for a distinctive filename.

Open

The Open command provides you with a file selection dialog with which you can
open an existing password file from on your harddisk or from a floppy disk.

-21 -
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Quick Open

The Quick Open command lists the files found in two folders: “Startup Items” and
“Cabinet”. Quick Open is a convenient way to open files without going through the
tile selection dialog.

Close
The Close command closes the currently active password file. If you have modified
it, you will be prompted to save changes before closing it.

Save
The Save command writes the currently active password file to disk. Functionally
equivalent to the Save button on the toolbar.

Save As
The Save As command enables you save the currently active password file under a
different name.

Revert to Saved

The Revert to Saved command enables you retrieve the previously saved version of
the currently active password file as stored on disk. Use this command to undo
changes you have made to the currently active password file.

-22 -
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Helper Settings
The “Helper Settings” command allows you to modify the interaction of Web
Confidential with two external Internet applications.

5ettings

_/( Remote Login \'-./ POP Accounts \

— [+f Automated Login

Login prompt: | EKER|

Password prompt: | code

[[] Loginin the background

The application BetterTelnet 2.0 can do an automated Togin if you specify the
abowve two prompts. BetterTelnet’s Home Page is at:
<http:s S cstone. net A rbraund mac Atelnet /-

[Eance] ]

Remote Login

If you enter the login and password prompts issued by a remote host in the two
fields displayed and activate the Automated Login check box, Web Confidential will
attempt to open a Telnet session with a host automatically using the toolbar's Go
button. This applies to hosts specified cards of the type Login Accounts only. This
will only work if you have Better Telnet 2.0 as your preferred Telnet application.

If the” Login in the background” check box is switch on, Web Confidential will login
in the background. It will switch to Telnet after the login process is completed.
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Pop Accounts

You can initiate reading your E-Mail from a POP server via Web Confidential. You
also need a copy of Microsoft Outlook Express on your hard disk. First, create a card
in the category “POP Accounts” and supply the fields: “POP Server”, “User ID” and
“Password”. Second, you need to create an empty new “E-Mail Account” in
Microsoft Outlook Express. Open the Preferences of Microsoft Outlook Express and
create a new account named “Blank Account”. It must be named exactly like this,
because Web Confidential will try to locate this account. (You only need to create
this account once.)

When you click the Go button in Web Confidential, the following actions will be
performed by Microsoft Outlook Express:

e The account “Blank Account” will be configured (temporarily)
* Your E-Mail will be read
e The account “Blank Account” will be erased.

Print

The Print command allows you to print the currently active password file. Some
options in Preferences determine what is actually printed. To change the printer
font, change this setting via Internet Config.

Quit
The Quit command allows you to exit Web Confidential. If any password files are
open and changes have not been saved, you will be prompted to saves changes first.

The Edit menu has the following commands:

Undo - Cmd-Z
Not yet implemented.

Cut - Cmd-X
Move the currently selected text to the Clipboard

Copy - Cmd-C
Copy the currently selected text to the Cipboard.

Paste - Cmd-V
Paste the contents of the Clipboard at the cursor location.

-4 -
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Clear
Delete currently selected text.

Select All - Cmd-A
Select all text within the currently selected field.

Find - Cmd-F
The Find command displays the Find dialog which enables you to search cards. It
offers two options:

e Wrap around: start the search from the current card and continue the search from
the top of the password file. Default: off

e Ignore case: perform case insensitive searches. Default: on
Functionally equivalent to the Find button on the toolbar.

Find Again - Cmd-G
The Find Again command repeats previous Find operation. It bypasses the Find
dialog.

Copy Password - Shift-Cmd-C
The Copy Password copies the contents of the password field of the current card to
the Clipboard.

Preferences

The Preferences command allows you to modify various settings used by Web
Confidential. Use the Preferences popup dialog at the top of the Preferences window
to select the page of settings you want to modify.

Mac OS 8 users work with a tab-folder Preferences window (see below).

Preferences

r/ﬁt Startup "'\./( Encryption Vlnternet VB&ckupVPri nting \‘l,\
I
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At Startup preferences page

Open Files in 'Startup Items' Folder

If the Open Files in “Startup Items” Folder option is checked, Web Confidential
automatically loads the password files found in this folder, which Web Confidential
installation program automatically placed in the Web Confidential folder on your
harddisk. If the a password file in the Startup Items folder is encrypted, you will be
prompted for the key before it is opened. Default: on

Enable Shared Menus

If the Enable Shared Menus option is checked, Web Confidential will install Shared
Menus in the Internet applications which it recognizes. If you are running any other
program which displays Shared Menus, such as Frontier, you may need to turn off
Web Confidential's Shared Menus; Web Confidential and Frontier cannot display
Shared Menus simultaneously. Default: on

Helper Applications
If the Launch Web Browser option is checked, your Web Browser will be launched
at startup. Default: off

If the Launch FTP Client option is checked, your FTP program will be launched at
startup. Default: off

If the Launch E-Mail Application option is checked, your E-Mail program will be
launched at startup. Default: off

If the Launch Telnet Application option is checked, your Telnet program will be
launched at startup. Default: off

If the Launch Newsreader option is checked, your Newsreader will be launched at
startup. Default: off

Note: Internet Config settings determine which applications are actually launched.

Encryption preferences page

Use the “Blowfish” Algorithm/Use PGP

Web Confidential allows you to encrypt your password files with either the
Blowfish algorithm or PGP. For more information about the pros and cons of these
two schemes, click the More Info button and follow the instructions to the
respective URLs.
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MacPGP 2.6.3/MacPGP 2.6.2

If you prefer to use PGP for encryption, you can use either version 2.6.3 or 2.6.2.
With MacPGP 2.6.3, you enter your key directly in Web Confidential. If you use
MacPGP 2.6.2, you will be passed automatically to MacPGP, where you enter your
key.

Internet preferences page

Web Browser

With the Web Browser popup menu, you can configure Web Confidential to
recognize the Web Browser you use. Default: Netscape Navigator. This allows you
to have more than one Web Browser installed on your harddisk and have Web
Confidential recognize the correct one. However, Web Confidential will first try to
use the Internet Config settings, if these are available.

Launch Internet Config
The Launch Internet Config button launches the program Internet Config, which
you need to configure Web Confidential's other Internet preferences.

Backup preferences page

Automatic Backup

If the Automatic Backup option is turned on, Web Confidential will make a backup
copy of your currently active password file when you save it. It will be called
"<filename>.bkup" Default: off

Printing preferences page

Print ATM/PIN Codes
If the Print ATM/PIN Codes option is turned on, the ATM/PIN Codes field of the
corresponding cards will be included when you issue a print command. Default: off

Print Notes
If the Print Notes option is turned on, all Notes fields will be included when you

issue a print command. Default: off

Note: you specify your preferred printer font via Internet Config.
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The Card menu has the following commands:

Add Card - Shift-Cmd-A
The Add card command allows you add a new card to the currently active password
file. Functionally equivalent to clicking on the Add button in the toolbar.

Delete Card

The Delete command allows you to delete the current card. Use this command
carefully, as it does not prompt you to confirm a card deletion. Functionally
equivalent to clicking the Delete button on the toolbar.

Next Card - Up Arrow or Page Down
The Next Card command moves you to the next card in the currently active
category.

Previous Card - Down Arrow or Page Up
The Previous Card command moves you to the previous card in the currently
active category.

First Card - Home Page
The First Card command moves you to the first card in the currently active category.

Last Card - Last Page
The Last Card command moves you to the last card in the currently active category.

Sort Cards
The Sort command sorts all cards in the currently active category.

Update - Cmd-U
The Update command ensures that changes you've made in card fields are synchro-
nized with the Web Confidential database. It also updates the arrow popup menu.

The Internet menu has the following commands:

WWW - Shift-Cmd-B
The WWW command launches your Web Browser or switches to it if it is already
running.

FTP - Shift-Cmd-F

The FTP command launches your FTP program or switches to it if it is already
running.
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E-Mail - Shift-Cmd-M
The E-Mail command launches your E-Mail program or switches to it if it is already
running.

Login - Shift-Cmd-L
The Login command launches your Telnet program or switches to it if it is already
running.

News - Shift-Cmd-N
The News command launches your Newsreader or switches to it if it is already

running.

Internet Config settings determine which applications are actually launched. This
program is included in Mac OS 8. System 7 users can download it from:

<ftp://ftp.share. conm pub/internet-confiquration/>
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Shared Menus

Web Confidential recognizes a number of Internet applications and takes advantage
of a feature of the Mac operating system called “Shared Menus” to install its own
menus inside those applications. The applications Web Confidential recognizes are:
Eudora, Claris Emailer, Outlook Express, MailSmith, Netscape Navigator, Explorer,
Fetch, Anarchie, NetFinder and MT-Newswatcher.

Note: Web Confidential recognizes Better Telnet but the current version (2.0b2) of
this Telnet program does not support Shared Menus.

The three Shared Menus Web Confidential installs are the Diamond menu, the
Key/Lock menu, and the Eyeglasses menu. (Here shown in the Netscape Navigator
menu bar).

Diew Go & % @ B s Help

The Diamond menu

The Diamond menu displays the following commands:

Add Web Page (only active in your Web Browser) - Cmd-K

The command Add Web Page enables you with just one mouseclick (or keystroke)
to create a new card in Web Confidential with containing the address of the current
Web page. It copies the title of the current page into the name field and copies the
current URL to the URL field.

Note: hold down the Option key while choosing the Add Web Page command and
the page will be bookmarked in URL Manager Pro instead. For more information

about URL Manager Pro, please visit:

<htt p://ww. url - ranager . coni >

Web Confidential
This command makes Web Confidential the active application.

WWW - Shift-Cmd-B

The WWW command launches your Web Browser or switches to it if it is already
running.
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FTP - Shift-Cmd-F
The FTP command launches your FTP program or switches to it if it is already
running.

E-Mail - Shift-Cmd-M
The E-Mail command launches your email program or switches to it if it is already
running.

Login - Shift-Cmd-L
The Login command launches your Telnet program or switches to it if it is already
running.

News - Shift-Cmd-N
The News command launches your newsreader or switches to it if it is already
running.

URL Manager Pro - Cmd-U
The URL Manager Pro command switches to Alco Blom's other bestselling Internet
utility, URL Manager Pro.

Note: the launch commands listed above only work if Web Confidential can find
the given application on your harddisk. To do this, it uses the data stored in the
Internet Config program. This program is included in Mac OS 8, System 7 users can
download it from:

<ftp://ftp.share.conl pub/internet-confiqguration/>

Refresh - Shift-Cmd-R

The Refresh command ensures that changes you make to the current Web
Confidential card are propogated throughout the system. In particular, this
command causes the Shared Menus that Web Confidential installs in your Web
Browser, emailer, and other applications to be updated with changes you may have
made.

Home Page
The Home Page command loads the Web Confidential home page in your Web
Browser.

Register Online

The Register Online command loads a Web Page where you can register Web
Confidential online.
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% The Key/Lock Menu

The Web Confidential Key/Lock Shared Menu lists the names of cards from your
password file that are relevant to the Internet application you are running.

Within your Web Browser, it lists the names of cards of the category WWW Pages.

Within your E-Mail program, it lists the names of the cards of the category E-Mail
Contacts.

Within your FTP program, it lists the names of the cards of the category FTP
Servers.

Within your Newsreader, it lists the names of the cards of the category Newsgroups.

Within your Telnet program, it lists the names of the cards of the category Login
Accounts.

Note: The current version of Better Telnet does not yet support Shared Menus.

$u™ The Eyeglasses Menu

The Eyeglasses Shared Menu lists the names of cards from the category Password
Manager. It provides you with quick access to frequently-needed passwords from
within all your Internet applications.

Choosing an item from the Eyeglasses Menu displays the Card Info Window for that
item (see next page).

By clicking the Copy Password button, you can copy the password to the Clipboard.
Using Cmd-V (Paste) you can then paste this password into a password prompt on
the Web. You can click the blue hypertext link or press the Go button to load the
Web Page.

An increasing number of Web sites require some form of user registration, whereby
you are required to enter a password to gain access to certain kinds of (personal)
information. This is not the same thing as a password-protected Web Page, hence
you cannot use the Go button to login automatically (see “Getting Started”).
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Card Info

—Card Info

Name: AMAzZon

Home Page: hittp: A S AMAZ0N.C0 M

1D/ Description: alco@xsdall.nl

Password: ssseee S
—Password Commands ———— —Form Commands

[ Copy #*C [ ID & Password I

| Enter %E | Submit |

| Cancel I || Go ¥#b ||

Microsoft Internet Explorer 4.01users have some more options in the Card Info
Window. They can use the ‘Enter’, ‘ID & Password” and ‘Submit” buttons.

Some sites require that you supply a password in a so-called “password input field’.
You can use the Enter button to automatically enter this field. After pressing the
“Enter’ button the dialog is dismissed.

Many sites actually require two pieces of information. A user ID (or e-mail address)
and a password. You can use the ‘ID & Password’ button to enter these two fields

automatically. After pressing the ‘ID & Password’ button the dialog is dismissed.

You can even try to also automatically submit the form. Pressing the ‘Submit’
button will first enter the user ID and password field and then submit the form.
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Encrypting Password Files

Web Confidential allows you to protect your password file with a so-called key. A
key is similar to a password. Once you have protected a password file with a key,
Web Confidential will prompt you for the key each time you open this file. In
addition, Web Confidential uses this key to encrypt the password file. This provides
provides excellent security for your password file.

Encryption is a complex subject and discussion of it is beyond the scope of this
document. Suffice to say that if you protect your Web Confidential password file
with a key ten characters in length, it is extremely unlikely that anyone would be
able to crack the code. Always create a key with mixed upper- and lowercase letters
and numbers; such a key is more difficult to crack. Your key can even be a multi-
word phrase (spaces are permitted). The key can be 56 characters (=448 bits) in length.

To ensure that you type your key correctly, Web Confidential prompts you to enter it
twice.

Unprotected password files and encrypted password files have slightly different
icons; an encrypted password file is recognizable by an unbroken key depicted on the
icon. This is to help you verify that a password file has indeed been encrypted.
Note: encryption is disabled in unregistered copies of Web Confidential.

When to encrypt

Encryption is optional; Web Confidential does not require you to encrypt a password
file. To help you decide whether to encrypt your file, we offer the following
guidelines:

e If you are the only user of your computer and it is located in your home or an
office to which only you have access, you probably don't need to encrypt your

password file.

e If other people have access to your computer or you have Web Confidential
installed on a laptop, we recommend you encrypt your password file.
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Warning

If you lose or forget the key you used to encrypt your Web Confidential password
file, there is no way you will be able to access the data in this file. Do not even
contemplate contacting us for help. We have not designed any kind of back-door
mechanism in Web Confidential to enable us to open an encrypted password file
without the key. If you have lost your key, your data is gone for good; your only
recourse will be to re-enter all your data in Web Confidential manually. Our advice:
if you encrypt your password file, use a key that you are certain you will never forget
or keep a copy of your key in a safe place.

Tidbits
“Startup Items” folder

Web Confidential automatically loads the password files found in “Startup Items”
folder, which the Web Confidential installation program automatically placed in the
Web Confidential folder on your harddisk. If a password file in the Startup Items
folder is encrypted, you will be prompted for the key before it is opened. You can
turn off the Startup Items feature by switching off the “Startup Items” folder option
on the At Startup page of Preferences (Edit menu)

“Cabinet” folder

Files in the”“Cabinet” folder are, together with the files in the “Startup Items” folder,
listed in the Quick Open submenu of the File Menu.

-35-



Web Confidential

Command Key Shortcuts
Cmd-A - Select All

Cmd-C - Copy selected text to Clipboard
Cmd-F - Find

Cmd-G - Find Again

Cmd-K - Add Web Page (Shared Menu)
Cmd-L - Open Card (Find Window)

Cmd-N - Create new password file

Cmd-P - Print currently active password file.
Cmd-Q - Quit Web Confidential

Cmd-U - Switch to URL Manager Pro

Cmd-V - Paste contents of Clipboard at cursor
Cmd-W - Close currently active password file
Cmd-Z - Undo (not yet implemented)
Shift-Cmd-A - Add Card (Mac OS 8 only)
Shift-Cmd-C - Copy Password to Clipboard (Mac OS 8 only)
Shift-Cmd-B - Launch Web Browser
Shift-Cmd-F - Launch FTP program
Shift-Cmd-M - Launch E-Mail program
Shift-Cmd-L - Launch Telnet program

Shift-Cmd-N - Launch Newsreader

-36 -



Web Confidential

Shift-Cmd-P - Open Preferences (Mac OS 8 only)
Up Arrow - Previous card

Down Arrow- Next Card

Page Up - Previous Card

Page Down - Next Card

Home Page - First Card

Last Page - Last Card
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